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Question Booklet Alpha Code
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Total Number of Questions : 100

Maximum Marks : 100
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INSTRUCTIONS TO CANDIDATES

The Question Paper will be given in the form of a Question Booklet. There will be four
versions of Question Booklets with Question Booklet Alpha Code viz. A, B, C & D.

The Question Booklet Alpha Code will be printed on the top left margin of the facing sheet
of the Question Booklet.

The Question Booklet Alpha Code allotted to you will be noted in your seating position in
the Examination Hall.

If you get a Question Booklet where the alpha code does not match to the allotted alpha
code in the seating position, please draw the attention of the Invigilator IMMEDIATELY.

The Question Booklet Serial Number is printed on the top right margin of the facing sheet. If your
Question Booklet is un-numbered, please get it replaced by new Question Booklet with same
alpha code.

The Question Booklet will be sealed at the middle of the right margin. Candidate should
not open the Question Booklet, until the indication is given to start answering.

Immediately after the commencement of the examination, the candidate should check that
the Question Booklet supplied to him/her contains all the 100 questions in serial order. The
Question Booklet does not have unprinted or torn or missing pages and if so he/she should
bring it to the notice of the Invigilator and get it replaced by a complete booklet with same alpha
code. This is most important.

A blank sheet of paper is attached to the Question Booklet. This may be used for rough
work.

Please read carefully all the instructions on the reverse of the Answer Sheet before
marking your answers.

Each question is provided with four choices (A), (B), (C) and (D) having one correct answer.
Choose the correct answer and darken the bubble corresponding to the question number
using Blue or Black Ball Point Pen in the OMR Answer Sheet.

Each correct answer carries 1 mark and for each wrong answer 1/3 mark will be
deducted. No negative mark for unattended questions.

No candidate will be allowed to leave the examination hall till the end of the session and
without handing over his/her Answer Sheet to the Invigilator. Candidates should ensure
that the Invigilator has verified all the entries in the Register Number Coding Sheet and
that the Invigilator has affixed his/her signature in the space provided.

Strict compliance of instructions is essential. Any malpractice or attempt to commit any
kind of malpractice in the Examination will result in the disqualification of the candidate.
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1. Which are the East flowing Rivers in India ?
1. Mahanadi
2. Narmada
3. Ganga
4. Tapti
A) 1,2,3and 4 B) Only (4, 3 and 1)
C) Only (1 and 3) D) Only (1, 2 and 3)

2. Who were the prominent lawyers gave up their practices as a part of Non-Cooperation
Movement ?
1. C. Rajagopalachari
2. Subhash Chandra Bose
3. Mothilal Nehru

4. C.R. Das
A) Only (1 and 3) B) Only (1, 2 and 4)
C) Only (1, 3 and 4) D) All of the above

3. ldentifies the following words related to which dynasty :
‘Koyil Adhikarikal’, ‘Aayiram’ and ‘Naaluthal?’
1. Ay dynasty
2. Venad dynasty
3. Ezhimala dynasty
4. Perumal dynasty
A) Only (1 and 2) B) Only (2 and 4)
C) Only 4 D) All of the above

4. Match the following :

1. Kola Swarupam a. Venad

2. Nediyiruppu Swarupam b. Kochi

3. Perumpadappu Swarupam c. Eranadu

4. Trippappur Swarupam d. Kolathunadu

A)1-a,2-¢,3-b,4-d
B)1-d,2-¢,3-b,4-a
C)1-c,2-b,3-a,4-d
D)1-b,2-c¢,3-d,4-a



132/25-T

5. Which of the following works included in the Manipravalam literature ?
1. Njanappana
2. Chandrolsavam
3. Vaisika Tantram
4. Ananthapuravarnnannam
A) Only (1 and 2) B) Only (2, 3 and 4)
C) Only (1, 3 and 4) D) All of the above

6. Examine the following statements as true :
1. Khariff period starts from November.
2. Rabi period starts from July.
3. Zaid period starts from June.
4. Bajra, Ragi and Jowar are millets.
A) All of the above B) Only (1 and 2)
C) Only (1 and 3) D) Only (1, 3 and 4)

7. Match the following :

1. Narora a. Rajasthan
2. Koodamkulam b. Uttar Pradesh
3. Kaiga c. Tamil Nadu
4. Ravatbhatta d. Karnataka

A)1-a,2-¢,3-b,4-d
B)1-b,2-¢,3-d,4-a
C)1-b,2-¢,3-a,4-d
D) 1-¢,2-b,3-a,4-d

8. Which of the following belongs to tribal revolt against the Britishers ?
1. Bhil Revolt
2. Kurichiya Revolt
3. RIN Revolt
4. Santhal Rebellion
A) Only (1 and 2) B) Only (2 and 4)
C) Only (1, 2 and 4) D) All of the above
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Identify the organisations and its founders.

1. Athmavidya Sangam a. Pandit K. P. Karuppan
2. Prathyaksha Raksha Daiva Sabha b. Vaikunda Swamikal

3. Araya Samajam c. Vagbhatanandan

4. Samathwa Samajam d. Kumara Gurudevan

A)1-a,2-¢3-d,4-Db
B)1-c,2-d,3—-a,4-b
C)1-b,2-¢,3-d,4-a
D)1-a,2-b,3-c¢c,4-d

Who got the Man of the Match award of the T20 final held at Barbados in 2024 ?
A) Rohit Sharma B) Jasprit Bumrah
C) Virat Kohli D) Heinrich Klaasen

Find the odd one.
A) PS/2 B) SMPS C) USB D) VGA

Which is the fastest memory in a computer ?
A) ROM B) RAM C) CACHE D) BIOS

Which of the following statements is/are correct ?
i. The OS manages all the resources of a computer.
ii. The OS provides an interface to the user.
iii. The program execution order is decided by the OS when multiple application
programs need to be run.
A) Only ii B) Onlyiandii
C) Only ii and iii D) All of the above (i, ii and iii)

A translator is a software that converts a program code from
A) High-level language to Unicode

B) High-level language to ASCII

C) High-level language to Machine language

D) High-level language to Assembly language

In which Windows version, Microsoft introduced the Start Menu ?
A) Windows 8 B) Windows 95
C) Windows 7 D) Windows XP
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Which of the following is not a Web Browser ?
A) Google Chrome B) Mozilla Firefox
C) Netscape Navigator D) Microsoft Outlook Express

What is the storage capacity of a standard DVD ROM ?
A) 4.7 GB B) 2.2 GB C) 700 MB D) 900 MB

Which is the correct method to select a paragraph in Microsoft Word 2007 ?
A) Shift + click anywhere in the paragraph

B) Double click anywhere in the paragraph

C) Ctrl + click anywhere in the paragraph

D) Triple click anywhere in the paragraph

Which tool is a part of the Clipboard Group in Word 2007 ?
A) Format painter B) Shapes C) Smart Art D) Page Break

Which of the following option is not a paragraph formatting option in Word 2007 ?
A) Alignment B) Spacing C) Indentation D) Orientation

What is happening when enabling kerning for fonts option in Word ?
A) Stretches the selected characters vertically

B) Adjust the spacing between particular pairs of letters

C) Scale the text horizontally

D) Lowered the letter position by selected points

Which of the following statements is/are true in the aspects of templates in MS Word
2007 ?
i. Can create a template from an existing document.
ii. Can create a template from an existing template.
iii. Can create a macro enabled template.
A) Onlyi B) Onlyiand ii
C) Only i and iii D) All of the above (i, ii and iii)

What maximum levels are supported in a multilevel list in a Word 2007 ?
A) 7 B) 8 C) 9 D) 10
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Which of the below option is not listed under the “Select Recipients” command in the
“Start Mail Merge” group for mail merge ?

A) Import from a CSV file B) Choose from Outlook Contacts

C) Type a New List D) Use an Existing List

In Word, the feature Gutter margin is used for
A) To insert numbers in the margin

B) To manage better document binding

C) To insert images and shapes

D) To improve printing quality

Which shortcut key is used to paste the copied content in Word ?
A) Ctrl + Shift + P B) Shift+ T C) Ctrl+V D) Alt+C

Which text wrapping style wraps the text around the graphic in an irregular shape
bounding the actual image in Word ?
A) In Line with Text B) Tight C) Square D) Through

Which of the below option helps the users to insert a large capital letter used as a
decorative element at the beginning of a paragraph ?

A) Drop Caps B) Word Art C) Symbols D) Header

What is the size of an A4 paper ?

A) 148.5 mm x 210 mm B) 210 mm x 297 mm

C) 105 mm x 148.5 mm D) 297 mm x 420 mm

What command is used to assign a name to a specific point in a Word document ?
A) Header B) Macro

C) Page Number D) Bookmark

How does the shortcut key Ctrl + | in Word works ?

A) Makes the selected text italic B) Increase the font size

C) Add an indent to left D) Capitalize the selected text

Which of the following is not a method for creating a table in Word 2007 ?
A) Using the Insert Table command

B) Drawing the table with the mouse

C) Using the Convert Text to Table command

D) Using shortcut key Ctrl + T
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Which of the following is a way to insert a page break in Word 2007 ?
i. Pressing Ctrl + Enter.

ii. Double-click on the left mouse button.

iii. Selecting the Page Break command from the Insert tab.

A) Only iii B) Both i and iii

C) Both ii and iii D) All of the above

How do you secure a document from editing in Word 2007 using a password ?
A) Click on the “Review” tab, then click on “Protect Document”

B) Click on the “View” tab, then click on “Encrypt Document”

C) Press Cirl + P

D) None of the above

Which of the following tabs contains the option to create charts in Excel 2007 ?
A) Home B) Insert C) PagelLayout D) Review

Which of the following functions can be used to find the highest value in a range of
cells in Excel 2007 ?

A) TOP B) MAX C) COUNT D) SQRT
In Excel 2007, what is the maximum number of rows in a worksheet ?
A) 16384 B) 44165 C) 65536 D) 100000

In Excel 2007, what is the keyboard shortcut to delete a selected row ?
A) Shift + D B) Ctrl + — C) At+R D) Shift + Alt + X

Which of the following options allows you to Freeze Panes in Excel 2007 ?
A) Click on the view tab and select Freeze Panes

B) Right-click on the row or column header and select Freeze Panes

C) Select a row or column and press Alt + F + P keys

D) None of the above

Which of the following Excel 2007 features is used to analyse data by creating tables
and charts based on it ?

A) Goal Seek B) Conditional Formatting

C) Thesaurus D) PivotTable

Which of the following chart types in Excel 2007 is best suited for displaying trends
over time ?
A) Pie chart B) Column chart C) Line chart D) Scatter chart
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Which Excel 2007 feature is used to create a formula that adjusts its cell references
relative to the position of the formula in the worksheet ?
B) Absolute references
D) Circular references

A) Relative references
C) Mixed references

Which of the following is not a valid Excel 2007 function for text manipulation ?

A) LEFT

B) RIGHT

C) UPPER

What is the purpose of slide transitions in PowerPoint 2007 ?
A) To animate objects on a slide

B) To move from one slide to the next
C) To apply visual effects to a slide
D) To modify the layout of a slide

D) CENTRE

Which of the following is not a type of animation available in PowerPoint 2007 ?

A) Entrance

B) Emphasis

C) Exit

What is the default file extension used by PowerPoint 2007 ?

A) .pptx

B) .ppt

C) .ppx

What is the purpose of the slide master in PowerPoint 2007 ?
A) To add animations to objects on a slide
B) To apply formatting to all slides in the presentation
C) To insert multimedia files into a presentation

D) To set the slide timings for the presentation

D) Rotation

D) .pptm

What is the keyboard shortcut for starting a slideshow from the beginning in

PowerPoint 2007 ?
A) F1

B) F2

C) F5

D) F9

Which of the following is not a way to format the background of a slide in

PowerPoint 2007 ?
A) Using a solid color

C) Using a picture or texture fill

B) Using a gradient fill

D) Using a 3D effect

What is the keyboard shortcut for adding a hyperlink to text or an object in

PowerPoint 2007 ?
A) Ctrl + K

B) Ctrl + H
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For what purpose do we use the line space disengaging lever ?

1. Paper release

2. Marginal release

3. Variable line spacing

4. None of the above

A) Only 2 B) Only 1 C) Only 4 D) Only 3

Which of the following Movement is not correct in the case of Ribbon Movement ?
1. Lengthwise Movement

2. Step By Step Movement

3. Up and Down Movement

4. Automatic Reverse Movement

A) Only 1 B) Only 2 C) Only 4 D) Only 3

Which document we use triple line space while typing ?

1. Office Notes

2. Commercial Purpose

3. Legal Document

4. None of the above

A) Only 3 B) Only 2 C) Only 1 D) Only 4

The main part of the Dog Block is

1. Pinion Wheel

2. Escapement Wheel

3. Ratchet Wheel

4. None of these

A) Only 1 B) Only 3 C) Only 4 D) Only 2

In Proceedings “To address” is given in the

1. Top left

2. Top right

3. Bottom left

4. Bottom right

A) Only 4 B) Only 2 C) Only 3 D) Only 1
-10-
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Each type bar is having
1. 1

2. 4

3.2

4. None of these

A) Only 2 B) Only 4

Another name of mainspring tension is

1. Key tension

2. Rack tension

3. Carriage tension
4. None of these
A) Only 2

C) Only 1

Which key is used to get equal column ?

1. Space bar

2. Tab Key

3. Tabulator

4. None of these

A) Only 1 B) Only 2

Dog Block is connected to the
1. Carriage lever

2. Back spacer

3. Non-character key

4. Character keys

A) Only 4 B) Only 3

Universal bar is connected to

characters.

1. Mainspring
2. Pinion Wheel
3. Dog Block
4. Ribbon Gear

A) Only 1 B) Only 2

C) Only 3 D) Only 1
B) Only 4

D) Only 3

C) Only 3 D) Only 4
C) Only 1 D) Only 2
of a typewriter.

C) Only 3 D) Only 4
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Fill in the blanks using an appropriate article.

He waited for hour and a half for lunch.

A) A B) An

C) The D) None of these

He sat his friend.

A) Beside B) Besides C) Between D) Along
My brother is boy in his class.

A) Tall B) The tallest C) Taller D) Astall as
| saw a of dogs.

A) Herd B) Pack C) Gang D) Flock

Choose the correct passive form of the sentence given below.
A) The old woman will have helped by him.

B) The old woman will being helped by him.

C) The old woman will be helped by him.

D) The old woman would have helped by him.

My friend has too many irons in the fire. (Find out the meaning of the underlined
idiom)

A) He is engaged with many problems

B) He is having many qualities

C) He is having many drawbacks

D) He is engaged in too many enterprises at the same time

He seemed affected by diffidence. (Identify the antonym of the underlined word)
A) Confidence B) Valour C) Cleverness D) Seriousness

I (attend) the class since 10:00 am.
A) have attended B) am attending
C) had attended D) have been attending

| went for a picnic to relieve the tedium of everyday life. (Choose the synonym of the
underlined word)

A) Boredom B) Tiredness C) Harshness D) Tension

Honour and glory his reward.

A) are B) is C) have D) were
-12-
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If they had requested me, | them.
A) Would help B) Will help
C) Will have helped D) Would have helped

Raju is a person who builds in or works with stone. (Choose one word for the
words underlined)
A) Goldsmith B) Mason C) Blacksmith D) Carpenter

“Call the police”, said the old lady to her son. (Change into Indirect Speech)
A) The old lady asked her son for calling the police

B) The old lady commanded her son must call the police

C) The old lady commanded her son to call the police

D) The old lady commands her son to call the police

Find the correct word from the following words.
A) ecsentric B) tution C) accommodation D) spacimen

Varun’s parents help him to overcome his difficulties.
(Choose the appropriate phrasal verb of the underlined word)

A) get through B) get over C) get across D) get along
Sachin played well, ?

(Use appropriate question tag)

A) did he B) didn’t he C) do he D) don’t he

“The door must be kept locked” is an example of
A) Assertive sentence B) Imperative sentence
C) Exclamatory sentence D) Interrogative sentence

Pick out the adjective from the given sentence.
| am a clever boy.
A) boy B) a C) clever D) am

The gender of the word ‘Duchess’ is

A) masculine B) common C) neuter D) feminine
He is neither smart brave.
A) or B) and C) but D) nor
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OB TOSTLILIWIT FnmLh FTTOLILPSSHISSHeGHT cTevsTenllbend 6THFmeT ?

A) 3 B) 5 C) 10 D) 7

BL FEB RIS etim ?

A) g B) 8w Geunewsrid C) &@pLi D) wpesflour
QW senev 64. @QF6v ety ?

A) L@pauLb B) s@Loi C) @%b D) wremev
“Wall have ears” — LiypGlomfluflesr sLlprésLb.

A) »&&LD LISHLD LmidgIL1 GLs B) 2arGpn() @bz eump

C) @ssamngdh@ bH®T LIFenF D) @yens Oeul’ &b ymlwing)
@ OluThlseiley ey 2

A) seal B) cafl C) 2army D) Gloul
“oarmiE ML’ — 6T16TLIZ| ?

A) aleners 0% mens B) 2 cuewing 05 mens

C) 2 ibewing0lsmen5 D) wewr 05 mens

LDIT + LDJLD = LOALDJLD — GTGTLIFGHT Ljeworidd) allG 2

A) Goupmiewiols LessTiFS) B) Quiebry Ljewrids)

C) adsmls Ljestidd) D) Gsmesimed

“LiessTLy eTaTILIBeuS] LT DIbSI @(LPSHS — 6T6dn LITL_6O @)L LD
Qupm mIevL ?

A) pHmen et B) sa030lsmem5

C) &miBblsremns D) wpebemevriim ()
SBLOTSD DG (LIS QUTPEM®S ?

A) 915 aumpsens B) yw eumpsiens

C) saray aumphens D) spy eurpsens

“QppSLOpF ClFeval)’ — ereitp FApLiLy OLwr Cluppaeur.

A) FeoresTs) B) wrsall

C) B wiHH D) eeremeuwimi
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91. L, LGTenLd CIFTDHEGT 6T(LPS @ LD.
A) af®), 10 B) m1(, &1

C) smuis6ir, Hesh%eir D) wewi_, LiewL_ 6T

92. “eumguw Liufewysd Hevsr_ CLTGIFBeveVTLD eumy Georest” — G163IMY LIMLY WGUT ?

A) eueTareumi B) smywonesteuir  C) oyl D) ®mepevrt

93. s 2 BeL_UNGT SHeng ?

A) H@p.al.s. B) afgomupesilourt

C) wenpLoenewiLy Fei D) 5. LdFepiid%
94. auevellar 61(LpSsIshHeT LIDdEGHLD @)L LD 2

A) epsh@ B) wmiy

C) sev D) Glsmessrent_
95. GlsarGgmail_ Glmplsefley speiimy 2

A) Camesst_im B) 9gm@ul C) setreor_Lb D) Osamis
96. sLAfleb Carepdlw (LpFed ST 618 ?

A) el 1SS TILD B) Qsrevsmiiuib

C) &LbLIgTLDTUIGHSTLD D) wewflGLossemnev

97. “OleueiTenar 91y SHTesr” — 6TGTLIGI ?
A) Osmflevma@ 6wt B) wesrLim@uiwii
C) @)L eumr@olLwir D) smeveum@ et

98. SHBSGMIeV, YDSHILILITEID 2 GTaT YPETIBISGCT 615HFOCT ?

A) 28 B) 38 C) 25 D) 35
99. o1 (WS0IsTemS BINFfey HLPLD, LIDLPLD 2 L W BV

A) sBISIMI B) Lmmprenim

C) uMum_ev D) &nub0lsmens

100. “2 arOloreiiy eweusgILt LpibOlLnesmy Guseaumt
2 pay sevaurens Geuess(RId” — @)LimL_6v euflser @)L b Qb HreL 2
A) GaibLimeuewt B) mevauy)

C) epgiang D) S@eumpum
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